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Creating this issue of Plugs ‘N Pixels
involved a bit of extra effort due to its theme
of getting your family under control. I actually
researched and charted my family tree as part
of the production, scanning thousands of old
photos and documents in the process!

In the following pages you’ll discover some
wonderful applications and plug-ins that made
my project possible (plus fun and easy to do).
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Genealogy, or the search for your ancestors, has long been a most popular pastime. Historical document
archives available via the internet bring the history of your family alive, sometimes almost instantly. What
these archives don’t usually provide you with is access to the old family photographs that only reside in
your relatives’ basements or attics, hidden, forgotten, waiting to be discovered once again.

But once you uncover these images and related historical materials, what can you do with them? How can
you improve their appearance, organize them and eventually share them with your relatives? That’s what
this issue of Plugs ‘N Pixels is all about. I hope you’re inspired to begin your own family history project.

Retouch by Wm

getting your family under control



To get started, you’ll need to
gather two types of things: Old family
photographs and family facts.

The photos will come from old
family albums, which are most likely in
the possession of your older relatives.
In my case, since I currently live in
California, my generous relatives back
East mailed me items from their
photo collections (using Flat rate
USPS Priority Mail boxes and
envelopes; two- to three-day
delivery was normal and reliable).

I spent months scanning every single
photo, document and piece of
correspondence, naming the image
files using any date and identification
information available. I put the date
first in the file name, so the photos
arranged themselves chronologically
on the computer.

Depending on the scanner, I used
either the native driver (for batch
scanning) or VueScan (screenshot at
right), which supports almost every
scanner ever made, old and new,
with high-end functionality.

Using family facts gathered from
relatives combined with internet
resources such as Ancestry.com and
HeritageQuest, I was able to discover
ancestors I didn’t know I had! This
factual information was input into
genealogical applications such as
MacFamilyTree, iFamilyForLeopard and
MemoryMiner for presentation.

Hamrick’s VueScan supports hundreds of scanners, old and new.

getting your family under control

http://www.hamrick.com


www.plugsandpixels.com/macfamilytree.html

Having never done any sort of family chart before, I started my project with
Synium’s MacFamilyTree. Being a visual person, I especially like its colorful graphical
representations of the data you input. Before I came across MFT, I had intended to
create such charts manually in an illustration application. Now there’s no need!

Use the Edit>Family Assistant area to enter each family member’s information
(name, sex, vital statistics, etc.). Edit>Persons displays a list of all your family
members, along with the place and date of birth and age at death. Double-click
on any name to bring up edit fields for that person. Add photos and other media,

add a partner and children and any important life events.
Edit>Families is a related function for full family units.

When all of the data is provided to it, MacFamilyTree can then work
its magic. Output a 3D Virtual Tree, Ancestor Chart, Fan Chart,
Descendent Chart, Timeline, Virtual Globe, Statistics, Genogram,
Kinship Report, Distinctive Persons fact list and much more.

MacFamilyTree’s
Descendent
view (left)

The colorful fan view.

http://www.plugsandpixels.com/macfamilytree.html


iiffaammiillyy ffoorr lleeooppaarrdd

Less flashy and more along the lines
of what one would expect from a
traditional genealogical application,
the new iFamilyForLeopard focuses on
each person (as opposed to families).

The screenshot below shows an
example of Queen Elizabeth of

England’s personal information (spouse, children, marriage date
and location, parents and ancestors, etc.

Photo galleries can be added for each person
(iFamilyForLeopard can handle almost 50 image formats, along
with basic cropping and editing functions), with support for drag-
and-drop from iPhoto, and an image transcription function.

Search your family using name, ID, Title, Birth Date or Place, Cause
of Death, Notes, Comments and more. Import and export
Gedcom files containing more than 100,000 people.

When you’re done, export your family history to the web to
share with scattered family members.

www.plugsandpixels.com/ifamily.html

(Family information shown here is from
the freely available Royal92 GED file.)

http://www.plugsandpixels.com/ifamily.html


MemoryMiner is not so much a genealogical application, but a cross-
platform digital storytelling vehicle that lets you present and explore your
family photos and data in a unique way. People, places and time are linked
together using the materials you provide – anything from old photos to
video clips to URLs to audio to documents. Even Google maps come into
play!

The various elements of your family story are linked to each other by way
of annotation layers identifying the people, places, dates and events
captured in each frame, and can be exported as an interactive online
presentation using highly advanced dynamic HTML and Flash.

1) Import images (simply by

dragging and dropping from a

folder or photo organizer like

iPhoto)

2) Create of a list of relevant

people and locations

3) Connect people and

locations to images

4) Add descriptions to images

5) Attach other digital media

to images

6) Select images for export

(other relevant media will be

automatically selected)

7) Export your photo-data

package to a server of your

choice

8) View and share your digital

story online

MemoryMiner is a great way to explore the various
stages of your ancestors’ lives, or even your own, using
photographs and any other media.

www.plugsandpixels.com/memoryminer.html

http://www.plugsandpixels.com/memoryminer.html


Begin your timeline by creating a new document and choosing a preset theme. Choices include Bluesy, Cherry Pie,
Earthy, Laser Printer, Path, Pleather or Rain Forest (my example used Path with a custom background image). You can
quickly import events to chart, such as Address Book, iCal, iPhoto, iTunes, RSS/Atom Feeds or System Profiler. For
the example here I used a Blank Timeline and imported presized images of my grandmother throughout her life,
adding the dates on which each photo was taken.

Timeline 3D takes the concept a step further and allows you to walk an audience through your timeline with an
interactive full-screen 3D view of your events. Use the keyboard or an Apple Remote to zoom into the details,
highlight events, and toggle between 2D and 3D perspectives.

Film makers, museum curators,
professors, novelists, grad students
and business leaders are the target
markets for Timeline and Timeline 3D,
both of which provide a unique way of
presenting your family photographs –
or any other kind of presentation-type
data – in a visually appealing way.

Working with presets that can be
further edited later, you create events
and drag images onto them. Export the
results as PDF, EPS, images, an interactive
Keynote presentation,
Quicktime movie or
email attachment.

Create professional-looking
presentations with minimal effort

www.plugsandpixels.com/timeline.html

http://www.plugsandpixels.com/timeline.html


An example of “positive” vignetting with
onOne’s FocalPoint plug-in

FocalPoint’s adjustable selective
focus, vignette and grain effects
turned this standard late-1800s
portrait into a more moody study.

www.plugsandpixels.com/focalpoint.html

onOne Software has come up
with a quick and easy way to add
selective focus and vignetting to your
images (especially where it doesn’t
already exist), whether they are
old or new.

I was able to breathe new life
into these classic family photos by
changing the plane of focus and/or
adding either positive (white) or
negative (black) vignettes (or you can
add none at all), while also controlling
the amount of film grain to be added.

The center of each effect can be
placed anywhere within the image you
wish, unlike with traditional glass camera
filters where it is always centered.

“FocusBug” adjustment handles help you
fine-tune the clear area within each
effect so the results are sized and
placed exactly as desired.
Effects are applied to a new layer,

and you can save presets made
from your favorite settings.

The 3D FocusBug at work, precisely
altering the plane of focus

SSAAVVEE
2200%%!!

http://www.plugsandpixels.com/focalpoint.html


To the modern eye, your family’s
collection of vintage black-and-
white photos may seem charming,
but after awhile they become a bit
bland. That’s where AKVIS Coloriage
comes in.

Coloriage is easy to use. My 13-year-
old daughter created this realistic
colorization, bringing a family
photo from 1946 back to life.
Simply choose a color and

outline various areas in
your image, and let
Coloriage do the
rest!

www.plugsandpixels.com/coloriage.html

AKVIS Coloriage includes a color picker as
well as a Color Library with presets such as
People, Fabric, Leave, Wood, Stone, Sky,
etc. to make your colorization jobs easier.

http://www.plugsandpixels.com/coloriage.html


ezine cover retouch challenge winner!
For this issue I thought I’d try a different approach to producing the cover art, which I normally

create myself. Over on the Retouch Pro forum (URL below) there are many members who are quite
expert at retouching (as you would expect!). So I put forth a challenge for anyone to retouch one of my
old family photos, in this case a formal portrait of steel factory worker Morris Mara, taken circa 1885.
Several Retouch Pro members came though with excellent work. I chose this retouch by Lonnie Kraemer
for its tasteful colorization, artful touches and allowance for additional elements.

Cover image created by Lonnie Kraemer (LonnieK), a prominent member of the RetouchPro
forum where we posted an open challenge to retouch a family photo for this issue’s cover.

See page 19 for more of Lonnie’s work as this issue’s sole Featured Artist.

www.retouchpro.com/forums

Lonnie says, “Colorizing old black & white photos
is one of the most rewarding undertakings of
digital image manipulators. The key to
successful, photorealistic colorizing is proper
preparation of the base image. My basic
workflow for colorizing portraits is thus: 1)
Restore, repair and retouch as necessary. 2)
Apply a slight overall sepia tone. 3)
Because the brightest highlights and
deepest shadows are going to resist color
tinting, flatten the contrast range. 4) Select
specific areas to be colorized (skin, hair,
eyes, lips, clothing articles, etc.). 5) Apply
appropriate colors to each selected area
using one or more of several techniques
(i.e. tint, fill, duotone, gradient, paint)
and adjust hue, saturation, luminosity
and opacity to conform. 6)
Paint/airbrush subtle color variations
(particularly to skin) to better mimic
reality. 7) “Paint with Light” to enhance
color toning and modeling. 8) Detail,
clean-up. 9) Take a long break,
then reexamine, scrutinize
and readjust to taste.”

http://www.retouchpro.com/forums


challenge runners-up

Here are the other submissions to the cover
challenge from Retouch Pro members. All are
excellent in their own way, and I was really amused
by Samoflak’s quick drawing at right.

by Samoflak

by Anito

by Cathy

Hunley

by riklehr

by KGM by A Frazier



www.plugsandpixels.com/vivacity.html

Topaz Labs has been releasing a
number of very interesting plug-ins
for still and video post-production.
For Photoshop, they offer Topaz
Adjust (see the Closing Artwork on
page 20) and Vivacity, shown here.

Vivacity performs multiple tasks,
such as noise removal, image
enlargement, JPEG artifact repair
and sharpening.

But perhaps the most exciting
thing about Vivacity is the results
you get when you push the
sharpening tools to the extreme!

The examples shown here
demonstrate the unique artistic
effects that occur when sharpening
is overdone. In the Advanced tab,
increase the Line Accent and the
Iterations while adjusting the
Sharpness, Radius and Noise
Threshold under the Main tab.

I especially like the way this effect
looks when used on foliage.

vviivvaacciittyy

SSAAVVEE $$7700!!
When you purchase 4
bundled products in

the Topaz plug-in suite

http://www.plugsandpixels.com/vivacity.html
http://www.plugsandpixels.com/adjust.html


Do you want some action? You’ll find it at Kubota Image Tools, where
they now offer the brilliant Kubota Action Dashboard to compliment their
actions. The Dashboard is the solution to an overcrowded Actions palette,
where too many actions make finding a particular one of them difficult at
best. The Kubota Action Dashboard is like a remote control for the various
Kubota action sets, where actions are accessible by genre (from a pulldown
menu) or even searchable via the input field.

Once you’ve installed the Kubota actions, access the Dashboard via
Photoshop’s File>Scripts>Kubota Action Dashboard. Scroll through the list
of actions in the Dashboard and quickly apply any of them to your image.

If you wish you can set up the Dashboard to respond to custom keyboard
shortcuts. Video and PDF tutorials are available to get you started.

www.plugsandpixels.com/kubotaactions.html

http://www.plugsandpixels.com/kubotaactions.html


1-click actions
Go RETRO with

If you’re in the market for inexpensive yet
excellent action sets, check out the 1-Click Actions
offerings from Mount Photography.

There are currently nine volumes available
(separately or in combination packs). I used a few
of these actions (with names such as Victorian,
Biscuit Tin Camera, Sepia Step and Box Brownie)
to create these examples of retro-fying a recently
captured image.

www.plugsandpixels.com/1clickactions.html

SSAAVVEE 1155%%!!
Use coupon code

“plugs2009”

Original

http://www.plugsandpixels.com/1clickactions.html


XaraXtreme is one of those rare graphics applications that is
comfortable working with images, vectors, page layout and HTML
export, without requiring the user to constantly switch among various
software packages to get the job done.

In the examples shown here, you’ll see XaraXtreme accomodates
those of you who are more traditional artists and illustrators, with
transparency support, soft vectors, shadows, pressure sensitivity, 3D
extrusion and more.

Photographers will enjoy XaraXtreme’s image handling speed,
flexibility with file formats, panorama-making tool, bitmap tracer and
plug-in support, to name just a few image-related features.

When you’re done creating your
work, put it together in a multi-page
document (with support for the
import and export of many common
file formats) or a multi-page website
created by choosing from among the
supplied professional templates.

www.plugsandpixels.com/xaraxtreme.html

Valery Kouleshov
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Xara

http://www.plugsandpixels.com/xaraxtreme.html


Everything new is old again! The folks
at Nik Software are known for their sets of
plug-ins for creative color effects, noise
reduction, sharpening and color and light
adjustments.

Now they’ve released Silver Efex Pro to
help you achieve the look of black-and-
white film. Not only are 20 preset styles
included (to emulate various monochrome
image effects), but Nik’s U Point technology
is included for selective control of the
tonality and contrast of your image.

Further, you can choose from several filter
colors (red, orange, yellow, etc.) and add
their filtration effects to those provided by
the presets; a list of vintage film types is
provided to choose from and stylizing
treatments (Toning, Vignette and Burn
Edges) are also available.

Silver Efex Pro makes it extremely easy to apply vintage black-and-white
effects to your color images. The antique-looking example of the girl in this
screenshot took exactly one click to achieve, and is shown without further
adjustments. A few more of the 20 total effects are seen as small previews
at the left of the screenshot.

www.plugsandpixels.com/silverefexpro.html

Choose from a wide
range of traditional film
presets ranging from
ISO 32 to 3200 (right)
and further adjust
Grain, Sensitivity and
Tonal Curve.

http://www.plugsandpixels.com/silverefexpro.html


Reveal hidden
details in the

shadows while
bringing highlights

under control

SSAAVVEE $$7700!!
When you

purchase the
Topaz suite

Original
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Instant HDR with

a single frame!

ADJUST DOES MORE THAN HDR!ADJUST DOES MORE THAN HDR!
While the results of this example are impressive enough,
Topaz Adjust does much more than revealing highlight

and shadow detail in extremely contrasty images. Starting
with any of the 18 presets, you can do anything from

simple exposure adjustment to controlling detail, color
and noise, achieving corrective and artistic effects once

reserved for plug-ins costing several times more.

Topaz
Adjust



ffeeaattuurreedd aarrttiisstt:: lloonnnniiee kkrraaeemmeerr
http://picasaweb.google.com/nickelcandy

Lonnie Kraemer (“LonnieK”) is one of a growing
number of retirees who finds working with
digital imagery a challenging, yet enjoyable
pastime. While he had some experience as a
professional portrait photographer in the
1970s, he is self-taught in the digital realm.
Many are surprised that he uses an older,
consumer level editor: Ulead's
PhotoImpact 8. "Quality digital image
manipulation doesn't necessarily
require the newest, most expensive
tools available," he insists. "A bit of
instinct, a decent grasp of
photography principles, a lot of
practice and knowing your tools
well goes a long way." Lonnie enjoys
learning new techniques and
sharing his efforts on several
popular related Internet forums.
His numerous wins in the
RetouchPRO.com monthly
contests attest to his
colleagues’ admiration of
his eclectic talents.

Original

http://picasaweb.google.com/nickelcandy


Created with: Topaz Adjust,
onOne PhotoFrame

Photo and artwork by:
Mike Bedford

CLOSING ARTWORK

http://www.plugsandpixels.com/adjust.html
http://www.plugsandpixels.com/photoframe.html
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